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TALLER DE REDES DE COMPUTADORAS 

 

TALLER 1: 

 

 

INVESTIGACIÓN SOBRE ORGANIZACIONES Y ESTANDARES 

 

Objetivo: 

 
Conocer el concepto de estándar así como las organizaciones involucradas en el desarrollo de 

estándares de telecomunicaciones 

 

 

Metodología: 

 
1) Visite el sitio –> http://ieee-elearning.org/outreach/file.php/1355/baseline/index.html 

Para conocer el concepto de estándar y los diferentes términos involucrados. 

-Siga el módulo What are standards? y conteste: 

¿Qué es un estándar propietario? 

¿Qué es un estándar de facto? 

¿Qué es la ANSI? 

Mencione tres organizaciones internacionales de estándares en las telecomunicaciones: 

¿Cuál es la diferencia entre una organización “acreditada” y una “no acreditada”, mencione 

un ejemplo de cada tipo de organización? 

 

2) Visite el sitio http://standards.ieee.org/develop/index.html 

Explique cómo se lleva a cabo el desarrollo de estándares por la IEEE. 

 

3) Visite el sitio: 

http://www.techstreet.com/cgi-bin/browse?publisher_id=95&subgroup_id=36721 

-Mencione al menos 5 estándares desarrollados por la IEEE 

 

4) Visite el sitio de la ITU-T http://www.itu.int/net/ITU-T/info/Default-es.aspx 

Explique: 

-¿Cuáles son las funciones de la ITU-T? 

-¿Quién puede pertenecer a esta organización? 

-Mencione dos estándares de esta organización. 

 

5) Visite el sitio de la IETF http://www.ietf.org/about/ 

Conteste las siguientes preguntas: 

-¿Que se encarga de normalizar la IETF? 

-¿Quién puede pertenecer a esta organización? 

-¿Que es un RFC? 

-Mencione dos ejemplos de RFC 

 

 

Entregar un reporte con los resultados obtenidos. El reporte debe contener: Portada, 

Introducción, Metodología, Resultados y Conclusiones personales. 

http://ieee-elearning.org/outreach/file.php/1355/baseline/index.html
http://standards.ieee.org/develop/index.html
http://www.techstreet.com/cgi-bin/browse?publisher_id=95&subgroup_id=36721
http://www.itu.int/net/ITU-T/info/Default-es.aspx
http://www.ietf.org/about/
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TALLER DEREDES DE COMPUTADORAS 

 

Taller2: 

 

 

Modelo OSI y Modelo TCP/IP 

 

Objetivo: 

 

Conocer los fundamentos de los Modelos OSI y TCP/IP y comprender la importancia de 

su utilización en el área de redes de computadoras 

 

 

Introducción 

 

Este taller le ayudará a desarrollar una mejor comprensión de las siete capas del modelo 

OSI. Deberá identificar las características de cada capa así como la terminología encada 

capa. El modelo OSI fue desarrollado por ISO para ayudar a crear un marco común para 

eldesarrollo de sistemas de telecomunicaciones.  

 

El modelo OSI nos ayuda a diagnosticar las fallas de telecomunicaciones dividiendo el 

proceso de networking (comunicación de hosts a servidores) en capas separadas donde se 

llevan a cabo las funciones e identificando las herramientas que ayudan a aislar el 

problema. Una buena comprensión del modelo OSI es fundamental para tener éxito en el 

mundo de las telecomunicaciones. Esta práctica de laboratorio permitirá además conocer 

el modelo TCP/IP que es la base para el funcionamiento de Internet. 
 

Metodología: 

 

 

 

1) Basándose en sus conocimientos del modelo OSI y los apuntes vistos en clase 

enumere las 7 capas del modelo OSI desde la superior hasta la inferior. Use un 

término Mnemotécnico para cada capa que le pueda ayudar a recordarlo y luego  

redacte una frase con las funciones básicas de la capa: 

 

 

 

 

 

 

 

 

 

 

 



Taller de Redes de Computadoras 

Dra. Mabel Vazquez Briseno 

No. Nombre Mnemotécnico Funciones básicas Estructura de 

datos usada 

7  

 

   

6  

 

   

5  

 

   

4  

 

   

3  

 

   

2  

 

   

1  

 

   

 

 

2) Relacione las siguientes columnas: 

 

 

____ Capafísica  a) Su principal función es la creación de 

marcos. 

 

____ Capa de Enlace de datos 

 

 b) Se encarga del enrutamiento. 

 

____ MAC 

 

 c) Establece el método de acceso para 

utilizar el medio de comunicación. 

 

____ Capa de red 

 

 d) Se encarga de la interacción de los 

usuarios y los datos de red. 

 

____  Capa de sesión 

 

 e) Se encarga de la entrega de mensajes 

completos. 

 

____  Capa de transporte 

 

 f) Se encarga del control de dialogo entre 

usuarios. 
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____  Capa de presentación 

 

 g) Convierte los datos de red a formatos 

específicos que puedan utilizar los usuarios. 

 

_____Capa de aplicación 

 

 h)  Se encarga de la sincronización de bits y 

define la velocidad de transmisión. 

   

 

 

 

3) Visite ahora el sitio http://docs.oracle.com/cd/E19957-01/820-

2981/6nei0r0r9/index.html 

 

Este sitio corresponde a un tutorial sobre TCP/IP de la compañía ORACLE,compañía 

líder en ofrecer productos y servicios relacionados con redes de computadoras, 

incluyendo sistemas operativos de red. 

 

Lea el tutorial y en base a la información obtenida conteste las siguientes preguntas: 

 

a) ¿Cómo se relaciona el modelo TCP/IP con el modelo OSI, haga una relación de 

las capas? 

b) Mencione tres protocolos de la capa de red incluyendo su utilidad: 

c) Mencione dos protocolos de la capa de transporte incluyendo sus funciones: 

d) De dos ejemplos de protocolos de la capa física: 

e) Liste cinco protocolos de la capa de aplicación: 

 

 

 

4) Desde la pantalla de comandos (MS-DOS), utilice la función ipconfig /all observe 

la información y conteste: 

 

a) ¿Qué información proporciona el comando ipconfig/ all? 

b) ¿Cuál es la dirección física de su tarjeta y a que capa del modelo OSI y del 

modelo TCP/IP corresponde? 

c) ¿Cuál es la dirección lógica de su tarjeta y a que capa del modelo OSI y del 

modelo TCP/IP corresponde? 

d) ¿Qué otros protocolos de estos modelos se muestran en la información dada 

por el comando? 

 

 

Resultados 

 

Entregue un reporte de la práctica con los puntos solicitados. 

 

El reporte debe contener: Portada, Introducción, Metodología y Conclusiones 

personales. 

http://docs.oracle.com/cd/E19957-01/820-2981/6nei0r0r9/index.html
http://docs.oracle.com/cd/E19957-01/820-2981/6nei0r0r9/index.html
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TALLER DEREDES DE COMPUTADORAS 

 

Taller3: 

 

 

CONFIGURACION DE UNA  RED LOCAL 

 

Objetivo: 

 

Implementar una red local y conocer las herramientas para configurar y administrar la red 

de área local. 

 

Metodología: 

 

1.- Realice el cable de red UTP cat 5 utilizando los conectores RJ-45 y el estándar  568-

B. Probar el cable para ver que funciona adecuadamente. 

 

2) Implemente ahora una red de area local (sin acceso a Internet) utilizando un 

conmutador, al cual conectara las PC’s de dos o tres equipos. 

 

3) Configure manualmente la tarjeta de red con los siguientes parámetros: 

 

La configuración de las direcciones IP debe cambiar utilizando direcciones privadas del 

tipo: 

Dir IP 192.168.1.1  a 192.168.1.15 

gateway 192.168.1.1 

netmask 255.255.255.0 

network 192.168.1.0 

broadcast 192.168.1.255 

-La configuración debe probarse en Linux y en Windows 

 

 

-LINUX: 

 

a) Configure la tarjeta de red de manera manual, para lo cual debe investigar el comando 

y sintaxis adecuada. 

Ejemplo, en Ubuntu: sudo gedit /etc/network/interfaces 

Y reincie la interface de red. 

sudo /etc/init.d/networking restart 

 



Taller de Redes de Computadoras 

Dra. Mabel Vazquez Briseno 

b) Haga pruebas de conexión a otras PC’s en la misma red con el comando ping 

 

c) Reconfigure la tarjeta de red, cambiando la dir IP, ahora con la interfaz grafica que 

provee la distribución de Linux instalada. 

 

 

-WINDOWS 

 

Utilizando los mismos parámetros utilice la herramienta grafica de configuración de red. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4).- Realice varias pruebas del funcionamiento de cada una de estas herramientas, 

indicando su utilidad y resultados obtenidos. Algunos ejemplos: 

- ping localhost 

- ping -c 4 yahoo.com 

-netstat –a 

-netstat –nr 

-traceroute 

-ifconfig (ipconfig) 

 

 

 

Elaborar un reporte sobre su investigación, actividades realizadas y resultados 

obtenidos.Contestesteademás las siguientes preguntas: 

 

1.- Explique el código de colores utilizado en el estándar 568-B para la conexión del 

cable 



Taller de Redes de Computadoras 

Dra. Mabel Vazquez Briseno 

 

2.- Explique la diferencia entre un cable UTP “directo” y uno “cruzado”, ¿para que 

se utilizan? 

 

3.-Explique porque los alambres deben estar trenzado en un cable UTP: 

 

4.- Explique cómo se realiza la configuración de la tarjeta de red en Linux 

 

5.- Explique cómo se realiza la configuración de la tarjeta de red en Windows 

 

 

6.- Explique cuál es la utilidad de las funciones: ping, netstat y la función ifconfig 

(ipconfig) 

 

El reporte debe contener: Portada, Introducción, Metodología y Conclusiones. 
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TALLER DEREDES DE COMPUTADORAS 

 

 

Taller 4. 

 
Análisis de marcos Ethernet 

 

Objetivo:  
 

Observar la información transmitida durante una sesión en una red Ethernet 

 

Introducción 

 

Para la práctica se usara un analizador de protocolos llamado Wireshark (anteriormente 

Ethereal). Técnicamente, Wireshark es un analizador de paquetes que utiliza una librería 

para capturar paquetes en su computadora. Wireshark es una herramienta gratuita 

ejecutable tanto en Windows como en Linux. Se recomienda obtener información del 

analizador en los sitios: 

 

(http://www.wireshark.org/docs/wsug_html_chunked/), 

(http://www.wireshark.org/docs/man-pages/),  

(http://www.wireshark.org/faq.html),  

 

Metodología 

 
Inicie su navegador favorito y Wireshark asegurándose que este bien configurado para la 

tarjeta de red apropiada.  

Inicie la captura de paquetes y manténgala durante varios segundos 

Utilice su navegador de Internet para visitar el sitio www.uabc.mx/gaceta y descargue el 

numero más reciente de la gaceta universitaria. 

 

a) Muestre la pantalla obtenida en WireShark 

b) Localice el paquete que contiene la información: GET /gaceta HTTP/1.1 

1) ¿Cuáles son los protocolos contenidos en el marco? 

c) Analice ahora solamente el protocolo Ethernet, para ello cambie las opciones de 

Wireshark en AnalizeEnabled Protocols deshabilite el protocolo IP y 

presione OK. 

Observe el marco Ethernet y conteste justificando las respuestas mostrando las 

pantallas obtenidas: 

2) ¿Cuál es el formato de la trama (los campos incluyendo nombre y tamaño)? 

3) ¿Cuál es el la dirección fuente? 

4) ¿A qué dispositivo corresponde esta dirección? 

5) ¿Cómo puede comprobar que esta dirección es correcta? 

6) ¿Cuál es la dirección destino? 

7) ¿Qué protocolo contiene el campo Type en el marco Ethernet? 

8) ¿Cuántos bytes contiene el campo Data? 

http://www.uabc.mx/gaceta
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Resultados: 

 
Entregue un reporte que incluya: Introducción, las respuestas a las preguntas bien 

justificadas incluyendo  las pantallas obtenidas y sus conclusiones personales. 
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TALLER DE REDES DE COMPUTADORAS 

 

Taller 5: 

 

CONFIGURACION DE UNA WLAN 

Objetivo: 

Establecer una WLAN utilizando DHCP y direcciones estáticas. 

 

Metodología: 

 

1) Investigue en qué consiste: DHCP y WEP. 

 

2) Conecte el enrutador inalámbrico linksys a su computadora con el cable de red, ingrese 

a la configuración utilizando: 

 

       Login:admin 

       Pwd: admin 

 

      3) Busque las utilidades necesarias y realice los siguientes pasos: 

 

         -En la configuración Wireless cambie a Manual y proporcione la información siguiente: 

 

a) Cambie el SSID al nombre de su equipo (Ejemplo: equipo2) 

b) Configure la dir IP estática del enrutador que será utilizada para proveer Internet al 

resto de las estaciones: 

 

IP: 148.231.215.175  (Si no está disponible probar la terminación 176-180) 

Mask: 255.255.255.224 

Gtwy: 148.231.215.161 

DNS: 148.231.192.6 

 

    b) Agregue seguridad a la red mediante una clave de configuración WEP que deberá 

proporcionar a las computadoras para conectarse al enrutador. 

    c) Configure el enrutador como servidor DHCP para que asigne direcciones IP a otras   

estaciones. Pruebe que otras estaciones se conecten al servidor DHCP. 

    d) Haga pruebas de funcionalidad entre las diferentes maquinas conectadas (ping) 

 

4) Inspeccione el resto de las utilidades configurables del enrutador, revisando también el 

manual incluido en el disco de instalación. 

 

En base a lo realizado conteste las siguientes preguntas: 
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1) ¿Cuáles son las características técnicas del enrutador: Velocidad, Frecuencias a las que 

trabaja, estándar IEEE que soporta? 

 

2)¿Qué es WEP y como se configura en el enrutador? 

3) ¿Qué otros mecanismos de seguridad soporta el enrutador? 

4) ¿Qué es DHCP y como se configura en el enrutador? 

5) Explique cuáles opciones presenta el enrutador para conectarse a Internet (Internet 

Setup) 

 

6.- Explique qué funcionalidades proporciona el enrutador en la opción de Configuracion 

Avanzada (Advanced Wireless Settings). 

 

7.- Mencione otras 3 funcionalidades que considere importantes que pueden configurarse 

en el enrutador, explique cómo se configuran : 

 

 

Entregue un reporte con sus resultados. El reporte debe contener: Portada, Indice, 

Introducción, Metodología, Resultados, respuesta a las preguntas y Conclusiones 

personales. 
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TALLER DE REDES DE COMPUTADORAS 

 

Taller 6: 

 

SIMULACION DE LA EXPANSION DE UNA RED EN OPNET 

 

1.- Objetivo: 

 

Utilizar un simulador de redes para analizar el comportamiento de una red y su 

desempeño al realizar una expansión de la misma. 

 

2.-Introducción: 

 

Para esta práctica se utilizara el simulador de redes OPNET. OPNET es un lenguaje de 

simulación orientado a las comunicaciones que es utilizado por grandes empresas de 

telecomunicaciones para evaluar el comportamiento de proyectos de redes antes de su 

implementación real. La compañía proporciona también una versión académica que se 

distribuye de manera gratuita, conocida como Opnet IT Guru Academic Edition, la cual 

se utilizará en esta práctica y que puede ser obtenida a través del sitio: 

http://www.opnet.com/university_program/itguru_academic_edition/. El simulador 

requiere una licencia renovable por 6 meses para lo cual es necesario ser usuario 

registrado del sitio de Opnet. 

 

 

3.-Metodología: 

 

En esta práctica se aprenderá a utilizar el simulador de redes para poder evaluar el 

comportamiento de un proyecto que puede presentarse en el mundo real, para ello se 

llevaran a cabo los siguientes pasos:  

 

-Construir una red de forma rápida 

- Recoger información estadística sobre las prestaciones de la red 

- Analizar las estadísticas obtenidas. 

 

En esta práctica, se utilizara el Editor de Proyectos de Opnet para construir la topología 

de una pequeña red de interconexión, posteriormente se planteará la expansión de la 

pequeña intranet de una empresa para evaluar su comportamiento. Originalmente, la 

empresa tiene una red con topología en estrella en la primera planta de su edificio de 

oficinas, y están pensando en añadir otra red más, también con topología de estrella, en 

otra planta.  Utilice Opnet para crear este escenario y observar el comportamiento de la 

red, verificando que la carga que se añade por la segunda red no va a afectar el 

comportamiento de la red. 

 

http://www.opnet.com/university_program/itguru_academic_edition/
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3.-1 Creación de la red inicial  

 

Para realizarlo sigua los pasos detallados a continuación: 

 

1. Inicie el programa IT Guru Academic Edition  

2. Seleccione File>New y elija del menú desplegable Project. Haga clic en OK. 

3. En el campo de Project Name, introduzca el nombre red1 y para el campo Scenario 

Name introduzca primer_piso, haga clic en OK.  

 

4. En la elección Initial Topology elija Create Empty Scenario y haga clic en Next. 

5. Seleccione la Network Scale, como Office; verifique que se encuentre seleccionada la 

casilla Use Metric Units y haga clic en Next 

 

6. En la siguiente pantalla se solicitan las medidas de la escala de red seleccionada. 

Introduzca los valores para X e Y = 100m y haga clic en Next 

  

7. La siguiente ventana Model Family solicita que seleccione la Tecnología de Red, para 

esta simulación seleccione Sm_int_Model_List y haga clic en Next 

  

6. Revise los valores introducidos anteriormente y haga clic en OK.  

7. El programa muestra el área de trabajo y una Paleta de Objetos, cierre la Paleta de 

Objetos.  

 

Con esto se ha definido las características iniciales del proyecto que se va a generar, 

siendo una red de área local. A continuación se utilizaran las herramientas de 

configuración rápida de Opnet para crear dicha red y analizar su comportamiento, para 

ello realice los siguientes pasos: 

 

1. Seleccione del menú Topology, la opción Rapid Configuration.  

2. Seleccione la opción Star del menú de Rapid Configuration y haga clic en OK, 

  

3. Se muestra un asistente de Configuración Rápida tipo estrella, introduzca siguientes 

valores: 

 

 

 

 

 

 

 

 

 

Hasta este punto se ha construido la topología general de la red, ahora se necesita agregar 

un servidor: 

Center Node Model  3C_SSII_1100_3300_4s_ae52_e48_ge3  

Periphery Node Model  Sm_Int_wkstn  

Number  30  

Link Model  10BaseT  

X  25  

Y  25  

Radios  20  
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4. Haga clic en el icono de la paleta de objetos.  

5. Se abrirá una ventana, seleccione el siguiente dispositivo Sm_Int_sever, y arrástrelo al 

área de trabajo, y presione el botón derecho para liberar la creación de objetos de este 

tipo.  

6.- Presionando el botón derecho sobre el node_31 cambie su nombre a Servidor 

 

7. Utilice ahora el enlace 10BaseT para unir el Servidor con el Switch.  

 

El siguiente paso, es agregar algunos dispositivos que permiten especificar la 

configuración y el perfil del tráfico de la red.  

 

8.  De la paleta de objetos, seleccione Sm_Application_Config y arrástrela al área de 

trabajo.  

9. De la misma forma seleccione Sm_Profile_Config y arrástrela al área de trabajo.  

 

Guarde el proyecto. La red debe verse como se muestra en la figura: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

De esta manera se ha construido la primer parte de la red, ahora es necesario analizar su 

comportamiento, para ello se elijen los parámetros que se desea analizar: 
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Para el servidor: 

 

1.- Haga clic derecho sobre nodo que representa al  servidor y seleccione la opción 

Choose Individual Statistics,  

t> Load(bits/sec). 

Para la red:  

 

3. Haga clic derecho sobre cualquier punto del área de trabajo, que no sea un nodo o un 

enlace y seleccione la opción Choose Individual Statistics.  

4. Active la siguiente estadística en el cuadro de diálogo Choose Results y haga clic en 

 

 

5.- Guarde el proyecto (CTRL + S) 

 

A continuación es necesario ejecutar la simulación del comportamiento de la red, para 

ello realice lo siguiente: 

 

1. Haga clic en el menú Simulation > Configure Discrete Event Simulation… o a 

través del botón Configure/Run Simulation  

2. Seleccione en el campo Duration el valor de una hora y haga clic en Run, para 

ejecutar la simulación. 

 

Una vez que haya terminado la simulación haga clic en el botón Close del cuadro de 

diálogo de simulación.  

 

Para el servidor:  

4. Haga clic derecho sobre el nodo Servidor y seleccione View Results.  

5. Del cuadro de diálogo de View Results seleccione Office Network.node_31> 

Ethernet> Load(bits/sec).  

 

  

Para la red en general:  
6. Haga clic derecho sobre un punto en el área de trabajo y seleccione View Results.  

7. Del cuadro de diálogo de View Results seleccione Global Statistics> Ethernet> 

Delay(sec) .  

 

En base a los puntos anteriores conteste lo siguiente: 

 

1) ¿Qué es el Sm_Int_sever? 

2) ¿Qué es el Sm_Application_Config? 

3) ¿Qué es el Sm_Profile_Config? 

4) En base a las estadísticas del servidor, analice y describa la grafica obtenida. 

5) En base a las estadísticas de la red, analice y describa la grafica obtenida e indique 

para que le serviría al administrador de red. 
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3.2  Expandiendo la red  

 

Para poder expandir la red, el primer paso va a ser duplicar el escenario, para ello realice 

los siguientes pasos:  

1. Haga clic en el menú Scenarios y del menú despegable elija la opción Duplicate 

Scenario.  

2. Introduzca expansion en el campo de Scenario Name, del nuevo escenario, 

posteriormente haga clic en OK.  

 

Nota: Al duplicar el escenario los enlaces, los nodos, las estadísticas y la configuración 

de la simulación se han duplicado bajo el nombre del nuevo proyecto que es expansion.  

 

El segmento de red del segundo piso, tiene que estar enlazado con el segmento de  red del 

primer piso. Por lo que ahora se tiene que construir el nuevo segmento. Para ello realice 

los siguientes pasos:  

 

1. Seleccione del menú Topology, la opción Rapid Configuration.  

2. Seleccione la opción Star del menú de Rapid Configuration y haga clic en OK.  

3.- Introduzca los siguientes valores: 

Center Node Model  3C_SSII_1100_3300_4s_ae52_e48_ge3  

Periphery Node Model  Sm_Int_wkstn  

Number  15  

Link Model  10BaseT  

X  75  

Y  62.5  

radios  20  

 

El siguiente paso será crear el enlace de comunicación entre las dos redes, para ello 

realice los siguientes pasos:  

 

1. De la paleta de objetos seleccione el router Cisco 2514 y arrástrelo al área de trabajo.  

2. De la paleta de objetos seleccione el enlace 10BaseT, para realizar la conexión del 

router hacia los conmutadores. 

 

3. A continuación cierre la paleta de objetos y guarde el proyecto, la red debe verse como 

se muestra en la figura: 
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Una vez creada la extensión de la red el siguiente paso es configurar los parámetros de 

duración de la simulación:  

 

1. Haga clic en el menú Simulation > Configure Discrete Event Simulation… o a 

través del botón Configure/Run Simulation  

2. Seleccione en el campo Duration el valor de 0.5 hrs y haga clic en Run, para ejecutar 

la simulación.  

3. Una vez que haya terminado la simulación haga clic en el botón Close del cuadro de 

diálogo de simulación.  
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Terminada la simulación debe llevar a cabo el análisis de los resultados obtenidos en la 

simulación del escenario de expansión.  

 

Para el servidor:  

 

4. Haga clic derecho sobre el nodo Servidor del escenario expansion y seleccione 

Compare Results.  

5. Del cuadro de diálogo de Compare Results seleccione Ethernet> Load(bits/sec).  

 

Para la red en general:  

 

6. Haga clic derecho sobre un punto en el área de trabajo y seleccione Compare Results.  

11. Del cuadro de diálogo de Compare Results seleccione Global Statistics> Ethernet> 

Delay(sec) .  

 

En base a los resultados conteste lo siguiente: 

 

1) En base a las estadísticas del servidor, analice y describa la grafica obtenida. 

2) En base a las estadísticas de la red, analice y describa la grafica obtenida e indique 

para que le serviría al administrador de red. 

3) ¿Cómo se comparan las graficas de los escenarios red1 y expansión? 

    4) ¿Es capaz el servidor de manejar la carga adicional de la segunda red? 

     5) ¿es aceptable el retardo total que existe en la red una vez que la segunda red 

   esta instalada? 

 

 

 

Resultados: 

Elaborar un reporte de esta práctica con todas las instrucciones realizadas, 

incluyendo las graficas obtenidas y las respuestas a las preguntas, incluir en el 

reporte: Indice, Introducción, Metodología, Resultados y Conclusiones. 

. 

 

 

 

 

 

 

 

 

 

 

 



Taller de Redes de Computadoras 

Dra. Mabel Vazquez Briseno 
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Taller 7: 

 

USO DE DIFERENTES DISPOSITIVOS DE CONEXIÓN EN UNA RED 

 

1.- Objetivo: 

 

Utilizar un simulador de redes para analizar el comportamiento de una red al utilizar 

diferentes dispositivos de interconexión. 

 

2.-Introducción: 

 

Esta práctica está diseñada para demostrar la necesidad de utilizar conmutadores en una 

red de área local. En la práctica se utilizara el simulador OPNET para diseñar una red 

utilizando primero solo un concentrador y posteriormente se agregaran conmutadores con 

el fin de que el alumno observe el comportamiento de la red.  

 

3.-Metodología: 

 

A) Uso de un Concentrador 

 

1. Inicie el programa IT GuruAcademicEdition 

2. Seleccione File>New y elija del menú desplegable Project. Haga clic en OK. 

3. En el campo de Project Name, introduzca el nombre Dispositivos y para el campo 

ScenarioNameintroduzca hub1, haga clic en OK.  

 

4. En la elección InitialTopologyelija CreateEmptyScenarioy haga clic en Next. 

5. Seleccione la Network Scale, como Office; verifique que se encuentre seleccionada la 

casilla Use MetricUnitsy haga clic en Next 

 

6. En la siguiente pantalla se solicitan las medidas de la escala de red seleccionada. 

Introduzca los valores para X e Y = 100m y haga clic en Next 

 

7. La siguiente ventana ModelFamilysolicita que seleccione la Tecnología de Red, para 

esta simulación seleccione Ethernet y haga clic en Next 

 

6. Revise los valores introducidos anteriormente y haga clic en OK.  
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7. El programa muestra el área de trabajo y una Paleta de Objetos, cierre la Paleta de 

Objetos.  

 

Con esto se ha definido las características iniciales del proyecto que se va a generar, 

siendo una red de área local. A continuación se utilizaran las herramientas de 

configuración rápida de Opnet para crear dicha red y analizar su comportamiento, para 

ello realice los siguientes pasos: 

 

1. Seleccione del menú Topology, la opción Rapid Configuration.  

2. Seleccione la opción Stardel menú de Rapid Configurationy haga clic en OK, 

 

3. Se muestra un asistente de Configuración Rápida tipo estrella, introduzca siguientes 

valores: 

 

 

 

 

 

 

 

 

 

4.- Cambie el nombre del concentrador a hub1. Guarde el proyecto. 

 

Hasta este punto se ha construido la topología general de la red, ahora se necesita generar 

tráfico en la red, para ello realice los siguientes pasos: 

 

1. Seleccione con el botón derecho cualquiera de las 16 estaciones  seleccione → 

Select Similar Nodes. Todas las estaciones de la red deben estar seleccionadas. 

2. De click derecho sobre cualquiera de las estaciones y seleccione → EditAttributes. 

a. Verifique la casillaApply Changes to Selected Objects. Esto es necesario para evitar 

tener que editar cada nodo individualmente.  

3. Expanda las jerarquias del atributo TrafficGenerationParametersy  

PacketGenerationArgumentsy cambie los valores a los que se muestran en la figura: 

 

 

 

 

 

 

 

 

 

 

 

 

Center Node Model  Ethernet16_hub  

Periphery Node Model  Ethernet_station 

Number  16 

Link Model  10BaseT  

X  50 

Y  50 

Radios  42 
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4.- click OK y guarde el proyecto. 

 

Note que el modelo de tráfico introducido corresponde a un modelo conocido como ON-

OFF, en el que los nodos generan trafico de manera intermitente. 

 

De esta manera se ha construido la primer parte de la red, ahora es necesario analizar su 

comportamiento, para ello se elijen los parámetros que se desea analizar: 

 

1. Haga clic derecho sobre cualquier punto del área de trabajo, que no sea un nodo o un 

enlace y seleccione la opción Choose Individual Statistics.  

2.Elija las siguientes estadísticas: 

 

  Ethernet Delay– De toda la red 

Traffic Received (in packets/sec) en los nodos 

  Traffic Sent (in packets/sec) en los nodos 

CollisioncountEn el concentrador 

 

3.- Guarde el proyecto (CTRL + S) 

 

A continuación es necesario ejecutar la simulación del comportamiento de la red, para 

ello realice lo siguiente: 

 

1. Haga clic en el menú Simulation> Configure DiscreteEventSimulation… o a través 

del botón Configure/RunSimulation 
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2. Seleccione en el campo Durationel valor de 2 minutos y haga clic en Run, para 

ejecutar la simulación. 

 

Una vez que haya terminado la simulación haga clic en el botón Close del cuadro de 

diálogo de simulación.  

 

3. Haga clic derecho sobre un punto en el área de trabajo y seleccione View Results para 

analizar los resultados obtenidos. 

 

B) USO DE UN CONMUTADOR 

 

A continuación cambie el dispositivo central por un conmutador (Ethernet16_switch) 

para ello: 

 

1. Haga clic en el menú Scenariosy del menú despegable elija la opción 

DuplicateScenario.  

2. Introduzca switch1 en el campo de ScenarioName, del nuevo escenario, 

posteriormente haga clic en OK.  

3.-Edite el nodo correspondiente al concentrador y cámbielo por un dispositivo 

Ethernet16_switch.Cambie el nombre del nodo a Switch. 

4.- Seleccione las estadísticas apropiadas para este dispositivo y ejecute la simulación por 

dos minutos nuevamente. 

5.- Para ver los resultados seleccione Compare Results en el área de trabajo 

 

C) SEGMENTACION DE LA RED. 

Ahora va a dividir la red en dos segmentos utilizando dos concentradores y un 

conmutador.  

1) Duplique nuevamente el escenario, llame al nuevo escenario hub_switch 

2) Utilizando la Paleta de Objetos agregue dos concentradores al escenario y 

reacomode la red de manera que se vea como en la figura: 
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3) Guarde el proyecto. 

 

Ejecute ahora las simulaciones simultáneamente de los tres escenarios, para ello realice lo 

siguiente: 

 

 

1. Seleccione ManageScenariosdel menuScenarios. 

2. Cambie los valores a <collect>o recollecten la columnaResultsde los escenarios 

3.- De click en OK para ejecutar la simulación. 

 

Para observar los resultados obtenidos elija la opción Compare Results. Para observar 

las graficas, seleccione las estadísticas deseadas y el botón SHOW 

 

En base a las simulaciones realizadas conteste las siguientes preguntas: 
 

1) ¿Cómo se comporta la red solo con el concentrador (hub) como dispositivo central, es 

aceptable el rendimiento?  

2) ¿Cómo se comporta la red solo con el conmutador (switch) como dispositivo central? 

3) ¿Cómo se compara el rendimiento de la red al cambiar el concentrador por un 

conmutador? 

4) ¿Como es el desempeño de la red al dividirla en dos segmentos? 

5.-¿Cuál es la mejor opción y porque? 

 

 

Resultados: 

Elaborar un reporte de esta práctica con todas las instrucciones realizadas, 

incluyendo las graficas obtenidas y las respuestas a las preguntas, incluir en el 

reporte: Indice, Introducción, Metodología, Resultados y Conclusiones. 

. 
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Taller 8 

 

Análisis de protocolos TCP/IP 

 

Objetivo:  
 

Utilizar herramientas que permiten observar y analizar los protocolos requeridos durante 

una transmisión de datos en Internet. 

 

Metodología:  

 

Parte I.- nslookup 

 

1.- Investigue la utilidad del comando nslookup, el cual puede ser utilizado tanto en 

Linux como en Windows. 

2.- Pruebe las siguientes instrucciones desde la ventana de comandos, analizando los 

paquetes enviados con Wireshark 

 

a) nslookup uoi.gr 

b) nslookup –type=NS uoi.gr 

c) nslookup mail.yahoo.com nic.grnet.gr 

3.- Muestre las pantallas obtenidas al ejecutar cada uno de los comandos y explique los 

resultados obtenidos y diferencias entre ellas. 

 

4.- En base a lo analizado en WireShark al ejecutar las instrucciones anteriores conteste 

lo siguiente, justificando sus respuestas con las imágenes obtenidas en wireshark 

 

a) Cual es el protocolo utilizado? 

b) Las peticiones son enviadas con UDP o TCP? 

c) Cuales son los puertos fuente y destino de las peticiones 

d) Cual es el formato de una petición (Query): 

 

Parte II.-tracert 

 

1.- Investigue la utilidad del comando tracert 

2.- Pruebe la siguiente instrucción y analice los paquetes con WireShark 

    a) tracert uoi.gr 

3.- Muestre la pantalla obtenida al realizar la instrucción y explique su funcionamiento 

4.- En base al análisis de los paquetes en WireShark conteste las siguientes preguntas 

justificando sus respuestas con las ventanas obtenidas: 

 

a) ¿Cuáles son los 3 principales protocolos requeridos al ejecutar una petición tracert? 

b) Muestre el contenido de un paquete ICMP en wireshark y explíquelo 
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c) ¿Cual es el tipo y código de los mensajes ICMP enviados?  

d) Muestre el contenido de un paquete ARP en Wireshark y explíquelo 

 

Resultados: 

 
Entregue un reporte con todas las respuestas así como sus conclusiones personales. 
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CONFIGURACIÓN DEL SERVIDOR DE INTERNET.- SERVICIO FTP 

 

Objetivo: 

 

Configurar las estaciones Ethernet para funcionar como servidores de FTP 

 

Metodología: 

 

1) Investigue cual es el demonio encargado de activar el servicio de transferencia de 

archivos (FTP) en su S.O (normalmente Wu-ftpd). Así como cuales son los 

comandos para activarlo, desactivarlo y revisar su funcionamiento. 

 

2) Activar el servicio Servidor FTP en su sistema de red. Crear un directorio para que el 

usuario anónimo lo pueda utilizar sin derecho a salir de este directorio. Para ello tendrá 

que cambiar los permisos de lectura de los directorios (investigue la utilidad de los 

comandos chmod, chown, chgrp) 

 

3) Debe ser posible poder acceder al servicio ftp utilizando la instrucción:  

ftp dir ip del servidor/ nombre del servidor 

 A continuación el nombre de usuario será: anonymous 

 

Modificando el archivo hosts que se encuentra en /etc es posible acceder a los sitios por 

nombre y no por IP, la sintaxis es la siguiente: 

 

Dir IP                           dominio                                   Alias 

192.168.1.1                 serv1.labredes.uabc.mx            serv1 

 

 

Probar entrar ahora al servidor utilizando el alias y no la dirección IP 

 

 

Resultados: 

 Probar con el usuario anonymous y con los otros usuarios dados de alta el servicio 

FTP 

 Probar las instrucciones put, get, ls, !ls 

 Checar con ? el resto de instrucciones y probarlas 
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Realizar un reporte de la práctica incluyendo todas las instrucciones realizadas, sus 

observaciones y conclusiones, además de contestar las siguientes preguntas: 

 

1.- ¿Para que se utiliza el servicio FTP? 

2.- ¿Para que se utiliza el usuario anónimo? 

3.- Al entrar con un nombre de usuario valido a FTP a que directorio se tiene acceso, 

de un ejemplo: 

4.- Para que se utilizan las instrucciones put, get, ls y !ls. 

5.- ¿Que otras instrucciones pueden utilizarse en FTP y cual considera más útil de 

ellas?.  

6.- ¿Existe una herramienta grafica en su S.O. para acceder al servicio FTP?, ¿Cual 

es? ¿Cuales son sus observaciones sobre ella? 
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CONFIGURACIÓN DEL SERVIDOR DE INTERNET.- SERVICIO HTTP 

 

 

Objetivo: 

Configurar un  servidor HTTP en Linux y analizar los protocolos y formato de paquetes 

intercambiados para tener acceso a la información. 

 

Metodología: 

 

 Investigar cual es el demonio utilizado en Linux para el servicio HTTP, así como 

el directorio en el que deben alojarse los archivos que contengan la página de 

internet a colocar en el sitio HTTP 

 

 Realizar una página de internet con la presentación de los miembros del equipo 

utilizando XHTML 

 

 

 Configurar la máquina para funcionar como servidor http y colocar la página creada 

en el directorio apropiado. 

 

 Revise el archivo de configuración de http (usualmente http.conf) 

 

 En otra  computadora acceder al servidor (en Windows o Linux) y utilice Wireshark 

para revisar los paquetes que se intercambian durante la conexión al sitio. 

 

 Aplique el filtro HTTP para observar solo las paquetes de este protocolo 

 

Resultados: 

 

Entregue un reporte con los pasos realizados, sus conclusiones y las respuestas de las 

siguientes preguntas 

 

1) ¿Cuál es el servidor HTTP utilizado en su distribución de Linux? 

2) ¿Qué parámetros importantes se muestran en el archivo de configuración de 

HTTP? 

3) Observando los resultados en Wireshark conteste las preguntas mostrando las 

pantallas obtenidas que justifican su respuesta 

a) ¿Qué estructura tiene el mensaje HTTP enviado para solicitar acceso al servidor? 

b) ¿Cual versión de HTTP está ejecutando el servidor y cual su navegador? 

c) ¿Qué lenguajes acepta el servidor HTTP? 
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d) ¿Cuál es el puerto fuente y destino de los paquetes HTTP? 

e) ¿Cual protocolo utiliza los puertos como direcciones?  

 

Anexo: 

 

Ejemplo de código XHTML 

 
<?xml version = "1.0" encoding = "utf-8" ?> 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN" 

  "http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd"> 

 

<!-- fonts.html 

    Ejemplo de diferentes estilos 

     --> 

<html xmlns = "http://www.w3.org/1999/xhtml"> 

<head> <title> Propiedades de letras </title> 

<style type = "text/css"> 

    <!-- /* CSS nivel documento */ 

    p.big {font-size: 14pt; 

           font-style: italic; 

           font-family: 'Times New Roman'; 

          } 

    p.small {font-size: 10pt; 

             font-weight: bold; 

             font-family: 'Courier New'; 

          }  

    --> 

</style>    

</head> 

 

<body> 

<p class = "big"> 

Coloque aqui la presentación del administrador de red 

</p> 

 

<h2 style = "font-family: 'Times New Roman';  

             font-size: 24pt; font-weight: bold"> 

Equipo N 

</h2> 

<h3  style = "font-family: 'Courier New';color:red; 

              font-size: 18pt"> 

1.- Nombre 1 

</h3> 

</body> 

</html> 
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